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Update 1 — July 2021  (Build 23.1.224)

Fix in this Update (U.S. and Canada Editions)
We fixed an issue in the 4-2 Payable Invoices/Credits window, which displayed the current default posting 
period, rather than the actual posting period, for a posted transaction. 
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Compatibility with Sage Estimating

Important! Sage 100 Contractor version 23.1 is not compatible with Sage Estimating version 20.1 and 
earlier versions. If you integrate Sage 100 Contractor with Sage Estimating, do not install Sage 100 
Contractor version 23.1 until you install Sage Estimating version 21.1.
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U.S. Payroll Tax Tables—July 2021 

Payroll tax tables have changed for  the following jurisdictions:

 l Idaho  

 l Kansas  

 l New York State and Yonkers 
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Canadian Payroll Tax Tables—July 2021

This section highlights federal and  provincial tax changes.

Federal Payroll Tax Changes
No federal payroll tax changes are included in this update.

Provincial and Territorial Payroll Tax Changes
The following provinces and territories mandated payroll tax changes, effective July1, 2021: 

 l New Brunswick

For detailed information on personal amounts, see the TD1 form for each province or territory.
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Enhancements in Version 23.1

This section describes the new features and enhancements you will find in  version 23.1.

We've been listening to you!
Sage thanks you for your product ideas! In version 23.1, we have incorporated the following top-ranked 
suggestions from the Sage Ideas site. Later sections in the Release Notes describe changes that require more 
detailed explanation.

New features in the 9-5 Takeoffs window
 l You can .select a group of continuous numeric cells in the 9-5 Takeoffs grid, and then view the Average, 

Count, and Sum of those cells at the bottom of the window.

Thanks for this suggestion Joel W..

Clear all button
 l When you export takeoffs, you can use a new [Clear All] button to clear the selections in the Export window all 

at once.

Thanks for this suggestion Jim S. and John M..

Simple Time Entry
Version 23.1 of Sage 100 Contractor provides a  convenient new time entry capability that employees on job 
sites can use to enter payroll information on their smartphones. It also provides a simple time entry window so 
that users without access to others' personal information can enter time into the payroll system.

Time entry through the Sage Time app streamlines payroll processing. Instead of employees having to fill in 
time cards that you or another employee must then enter manually into the Payroll system, time entries are 
submitted directly through the app into the Sage 100 Contractor "back office" for review and approval by an 
authorized person. 

After the time entries are approved, they are either sent immediately to Daily Payroll for processing or to the 
new 5-6-5 Create Timecards window, depending on settings you select for your company. Creating timecards 
involves generating  5-2-2 Payroll Records from the time entries so that you can process them with your 
regular payroll.
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Simple Time Entry enables employees who do not require access to other employees' personal information to 
process time entries, keeping sensitive information private while enabling efficient processing of payroll.

Note: Sage Mobile apps and associated Simple Time Entry functions require a subscription license for 
Sage 100 Contractor. For more information, contact your Sage business partner or your Sage customer 
account manager at 1-800-858-7095 or CREsales@sage.com.

Enabling Sage Mobile Apps for remote time entry

Before employees can use Sage mobile apps and before you can set them up as Sage Time app users, a 
Company Administrator needs to turn on the Sage Mobile Apps feature in Database Administration. 

Enabling Sage Mobile apps automatically installs and configures the Azure Active Directory Application Proxy, 
required for remote users to connect to the Sage 100 Contractor back office, and ensures that other required 
Windows services are turned on.

For more information, see the Database Administration help for Server Management > Enable Sage Mobile 
Apps.

After enabling Sage Mobile Apps in Database Administration, you can:

 l Define pay periods, time-off settings, mobile jobs and cost codes, and other settings for processing mobile 
time entries. (For more information, see the help for the new 5-6-6 Time Entry Settings window.)

 l Set up and invite mobile users to use Sage mobile apps. (For more information, see the help for the new 7-2-3 
Mobile Users window.)

 l Review, approve, and post entries sent by Sage mobile users. (See the help for the new 5-6-3 Review Time, 
5-6-4 Approve Time, and 5-6-5 Create Timecards windows.)

 l Print Time Entry reports using the new 5-6-1 Time Entry Reports window.

Users without rights to view sensitive employee information can use the new 5-6-2 Time Entry window to enter 
certain payroll information for other employees, including jobs, phases, equipment, cost codes, hours, and 
notes. (For more information, see the help for new 5-6-2 Enter Time window.)

Providing access to the 5-6-2 Enter Time window

To enable non-supervisory employees to enter timecard information, you need to give them access to the 5-
Payroll menu and the 5-6 Simple Time Entry sub-menu. 

We suggest that you create a security group (say, Time Entry) in the 7-2-1 Security Groups window. Then, 
assign that group to menu-level (F7) security for the 5 Payroll menu, the 5-6 Simple Time Entry sub-menu, and 
the 5-6-2 Enter Time window. 

If you currently apply security only to the 5-Payroll menu, you must turn on  security for all Payroll sub-menus 
(such as  5-2 Payroll Processing), limiting access to windows with sensitive information to groups that require 
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it. You may also have to turn on security for other windows under the 5-6 Simple Time Entry menu, assigning 
only security groups that require wider access to Payroll and excluding the Simple Time Entry group.

Providing access to the Enter Time window without compromising Payroll security

Setting up employees to use the Sage Time app

Before you start

 l In Database Administration, enable mobile apps to connect to Sage 100 Contractor.

 l Create a terms-of-use agreement that employees must accept before they can begin using the Time app. Save 
the agreement as a TXT file. 

If you need assistance creating the agreement, consult your legal counsel.

To enable employees to enter time through the Sage Time app:

 1. In Sage 100 Contractor, in the 5-6-6 Time Entry Settings window:

 l On the Pay Periods tab, select the pay period types and end dates for processing payroll for the Time app and the 
Enter Time window.

Note: You need to define at least one pay period before you can add mobile users.

 l On the Company Settings tab:
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 l Select the interval for which employees enter time in the Time app. You can select a 15-minute, 6-minute, or 3-
minute interval.

 l Specify whether employees must certify their entries before submitting time using the Time app. If you select the 
option to certify time, you need to enter the terms of the certification in the associated text box. 

To enable employees to enter a note when they certify their time, select the Include notes with employee 
certification.

 l Specify how time entries are processed in Payroll. You can either send approved time entries automatically to 5-
5-1 Daily Payroll or use the 5-6-5 Create Timecards to generate timecards for processing with your usual payroll 
in the 5-2-2 Payroll Records window.

 l On the Time Off Settings tab, specify:

 l The types of time off entries mobile users can enter (Sick, Vacation, and Holiday pay). 

You can also select how time off entries are named in the Time app. For example, if you have a single name for 
all kinds of time off, you can select Vacation for the type of time off in Sage 100 Contractor, but display PTO for 
the time off selection in the Time app.

 l Whether employees can see their time off balances in the Time app.

 l On the Mobile Jobs tab, the jobs employees can select when they enter time in the Time app. All employees will 
see the same list.

Note: You should limit the selection to jobs that are currently being worked not only to display a 
manageable list in the app, but also to reduce the possibility of errors. For the same reasons, you should 
remove jobs when they’re no longer needed.

 l On the Mobile Cost Codes tab, the cost codes employees can select when they enter time in the Time app. The 
Time app displays only the cost codes applicable to a selected job.

Note: You do not need to display all the cost codes in your system. Select only the cost codes that 
employees working on jobs will need.

Tip: You can drill down from the Mobile Jobs tab to the Budget window to view all the labor-related cost 
codes assigned to a selected job. If the job has a budget, but no labor cost codes, the employee will see all 
the cost codes assigned to the job.

 2. In the 7-2-3 Mobile Users window, authorize individual employees to use Sage Mobile Apps and send them 
invitations to submit time using the Sage Time app. 

Note: Employees need to install the Sage Time app, available in the App Store (for iPhone users) or in Google 
Play (for Android users). They'll use the information from their emailed invitation to sign in to your company on 
their mobile devices.

Entering employee time 

Employees without rights to view sensitive data can enter information from other employees' timecards using 
the 5-6-2 Time Entry window, although they need to belong to a security group with access to the Time Entry 
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window. 

This window lets you enter sufficient information to charge jobs or cost codes for an employee's hours worked 
(including overtime and premium hours), sick time, vacation, and holidays, but it does not disclose any pay 
rates or salary information. 

Information you enter in the 5-6-2 Time Entry window is similar to the information submitted using the 
Sage Time mobile app. 

Before you can enter time in the Time Entry window

Pay period types must be set up in the 5-6-6 Time Entry Settings window

To enter time in the Time Entry window:

 1. Open the 5-6-2 Time Entry window. (From the System Menu or My Menu, click 5-Payroll > Simple Time Entry 
> 2-Enter Time.)

 2. In the grid, use a separate line to enter information for each date, pay type, and employee, including the:

 l Date. Select a date using the date picker. The date order of the entries does not matter.

 l Employee. You can select any employee from Sage 100 Contractor Payroll. It does not have to be an 
employee who uses the Time app.

 l Job. You can select from a list of jobs that are set up for mobile time entry in the 5-6-6 Time Entry Settings 
window.

 l Phase (optional). Select the job phase, as needed.
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 l Equipment (optional). Enter the equipment that the employee operated when performing work on the job, if 
any. 

Note: You can select only equipment that is charged out at an hourly rate.

 l Cost Code (optional). You can select from cost codes that are set up for mobile time entry in the 5-6-6 Time 
Entry Settings window.

 l Total Hours, and if you have this information, which of those hours are subject to: 

 l Overtime pay

 l Premium pay

 l Sick pay

 l Vacation pay

 l Holiday pay 

Example: Say Natalia Formosa worked 9.5 hours in total, of which 1.5 are overtime. In this case, you 
would enter 9.5 in the Total Hours column and 1.5 in the Overtime Hours column.

Note: You can enter only one type of time for each time line. For example, you cannot mix premium 
hours, overtime hours, sick hours, and vacation hours on the same line.

 l Notes (optional). To add a note for a line, double-click in the cell to display the Notes window, where you can 
enter your notes.

 3. To save your entry, click the Save button on the toolbar, or click File > Save.

 4. To add another entry, click the New button on the toolbar, or click File > New.

After entering time

After you save a time entry, it must be approved by a user who has rights to print checks in Payroll. It may also 
need to be reviewed by a user with rights to review time entries, if your company requires a review. 

Reviewing remote time entries

Depending on your work flow, you can use the 5-6-3 Review Time window to review time entries before 
sending them to a payroll supervisor for approval. For example, your company may want the job supervisor to 
sign off on the time entries before the payroll supervisor approves them.

The grid in the 5-6-3 Review Time window includes the same columns as the Time Entry window, along with 
some additional columns and buttons you use to view or enter information about the review, including:
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 l Who submitted the entry (Submitted By). This information comes from the Time Entry window or the Time 
app.

 l Who reviewed the entry (Reviewed By). This information is filled in when you save the reviewed record.

 l For each detail line, whether the entry was accepted or rejected (Status). This information is filled in as you 
select each line, in turn, and then click [Accept] or [Reject].

 l For entries you reject, the reason why it was rejected (Rejection Reason). You must enter reasons for each 
rejected entry before you can save the record.

To display time entries in the grid, you need to select a specific pay period. If you defined more than one pay 
period type, you also need to select the pay period type for the entries you want to list (Weekly, Biweekly, 
Semimonthly, or Monthly). You can select an option to display time entries that were reviewed previously, if 
needed.

You can also apply filters to restrict the display of entries to specific dates, employees, or jobs.

Unlike the Time Entry window, you must supply a company email address from which to email a Time app user 
with the reason for rejecting their time entry when an entry is rejected.   Select the Email Setup for Rejection 
Notification on the Options menu to display the Email Settings window. 

Note: You need to provide an email address in this window even if you've set up email for other uses in 
Sage 100 Contractor. The Review Time window displays the last-used settings as the default for this 
window.

You can change the job, phase, equipment, and cost code until the entries have a Processed status (that is, 
when they are sent to Payroll). However, you cannot change the employee or the dates and times they submit.

Approving remote time entries

You use the 5-3-4 Approve Time window to approve time entries submitted through the Time app or through 
the Time Entry window. 
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This window is very similar to the Review Time window. However, here you approve, rather than accept, time 
entries using the [Approve] button. There is an additional status filter than you can use to restrict the display to 
entries that have a specific status. If you require employees to certify their time and include notes when they 
submit time entries using the Time app (specified in the 5-6-6-Time Entry Settings window) there may be 
additional columns for the employee certification and any notes they submitted with their time. 

Creating timecards for approved time entries

After you approve time entries, depending on your selection for the Process Time Entry Records By setting in 
the 5-6-6-Time Entry Settings window, entries are sent  either to 5-5-1 Daily Payroll for processing or to the 5-6-
5 Create Timecards window, where you can generate payroll records for them for each payroll period.

Enhancements for the U.S. Edition

Easily Allocate Inventory-Related Use Taxes 

Because you cannot post use taxes to inventory accounts, if you do not use the Post ‘use tax’ expense to 
option, you need to specify an overhead expense account for any inventory-related use taxes that apply to an 
invoice. (The option is on the Posting Accounts tab in the 1-8 General Ledger Setup window.)

With version 23.1, you can specify an overhead expense account to which to post use tax expenses for 
inventory items, as follows:  

 1. Open the 4-2 Payable Invoices/Credits window.  

 2. Click Options > Set Use Tax Expense Account for Inventory. 
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 3. In the Use Tax Expense Account for Inventory window, specify an overhead expense account and, if needed, 
the subaccount.  

Other improvements
Version 23.1 also includes the following improvements:

 l When exporting change orders, purchase orders, requests for proposal, and subcontracts from the 9-5 
Takeoffs window, you can click a new [Clear All] button to clear selected check boxes in the Export dialog 
box. 

 l We have improved the nightly backup feature so that it checks for database corruption every time it runs. If it 
finds corrupted data, the application displays a warning the next time you log in to Database Administration. 

Important! You should not continue to use a corrupted database, although you can still log in to Sage 100 
Contractor and print urgent reports. If you receive this warning, you need to restore your database from the 
most recent backup. If you continue to update the corrupted database, you will compound the problem and 
you will lose all your changes, anyway, when you restore from backup.

Until you restore you company from a backup, most windows will have a dark background as a reminder that 
the database should not be used, and you will receive reminders when you log in to the company.

For more information about what kinds of issues can cause database corruption, see Knowledgebase article 
Causes of SQL Server Database Corruption (KB 109765). 
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Do you have a product idea you want to share with us?
We want to hear it! 

To suggest a product enhancement when you're working with Sage 100 Contractor:

 1. On the Sage 100 Contractor desktop, click the Home & Resources tab >  Submit Product Idea.

 2. Log in to the Sage 100 Contractor Ideas site (or sign up).

 3. Describe your idea. 

 4. (optional) Browse through others' suggestions, and vote for the ones you love!

Or visit https://www5.v1ideas.com/TheSageGroupplc/Sage100Contractor any time you're online!
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Fixes in Version 23.1

Fixes in Both Editions
Version 23.1 includes the following software fixes in both the U.S. and Canadian editions:

Accounts Payable fixes
 l The starting check number is correctly updated in check-printing windows (such as the 4-3-5 Check Printing 

window) after you change the account. 

Database Administration fixes
 l    In Database Administration, when you create backups for multiple companies on demand, you receive a 

retention warning only at the beginning of the process, not for each company. 

Payroll fixes
 l    The 5-1-5-21 Worker's Comp report shows the correct job number on the first page header when the report 

includes multiple jobs. 

 l In the 5-2-2 Payroll Records window, the list that appears when you click Options > Salaried Employees > 
Create Salaried Employee Records excludes Inactive employee records. 

 l    After you save a payroll record in the 5-2-2 Payroll Records window, Sage 100 Contractor skips Inactive 
employee records when displaying the next employee record. 

Service Receivables fixes
 l You no longer encounter an error when viewing client service contracts in the 11-2 Work 

Orders/Invoices/Credits window. 

Takeoff fixes
 l In the 9-5 Takeoffs window, you can save a takeoff with calculated Sales Tax or PST greater than $100,000 

on a takeoff line. 
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 l In the 9-5 Takeoffs window, the Takeoff Recap by Bid Items now includes amounts for Alternate and Change 
Order bid item types in the totals. 

User List fixes
 l   In the 7-2-2 User List window, when you create a new user by inserting a row, the user settings for the row 

you selected before the insertion remain intact. Previously, when you were logged in as an administrative 
user with a SQL authentication method, the settings for the previous user would be reset. 

 l       In the 7-2-2 User List window, creating a new user by inserting a row a new first row in the grid does not affect 
the login credentials of the user in the second row. 

Miscellaneous fixes
 l    When a 2-4-51—Subsidiary Ledger report includes a description that uses the maximum number of 

characters, the description no longer runs into the Debit column. 

 l 6-4-2 Print Change Orders reports show correct prior changes and contracts. 

 l    Sage Advisor Update installs properly again. 

Note: If you had a problem running Sage Advisor Update previously, it will work as expected with the 
first update for version 23.1. 

 l Desktop shortcuts that go directly to specific reports no longer ignore security settings for the report’s parent 
menu. 

 l    We fixed a performance issue that caused Sage 100 Contractor windows that use spell check to open slowly. 

Fixes for the U.S. Edition
The following issue was fixed specifically for the U.S. Edition of Sage 100 Contractor:

 l In    5-4-2 State Reporting, Aatrix state reporting now includes amounts for Paid Family Leave Tax for 
Connecticut. We added new Aatrix codes that were released in March to support Paid Family Leave for 
Connecticut,  New York, and New Jersey. 

 l    You no longer need to enter hire dates when printing state-mandated W4 forms from the 5-4-2 State Forms 
window. (These reports are blank except for company information.) 

 l When you print    5-1-11 Certified Payroll reports that include 10-digit job numbers, if a job number exceeds the 
maximum value that Aatrix recognizes, Sage 100 Contractor modifies the first one to five digits until it creates 
a unique number. The last five digits of the job number are maintained for easier identification, and an 
asterisk is added to the beginning of the project name in the Aatrix Project List window. 
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 l    When creating a new calculation in the 5-3-1 Payroll Calculations window, when you set the Calculation Type 
to 1 – Deduct from Employee for tax types 10 – State Disability and 13 – Local Income Tax,  and then leave the 
field, Sage 100 Contractor now disables the Disposable earnings check box and does not select it. 
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API for third-party developer products

Notes for Third-Party Developers

To connect properly to version 23.1, you should recompile applications using DotNet 4.8.

 l    Net Due amounts for invoices are no longer recalculated when they are submitted to Sage 100 Contractor 
using the API either with a retention amount  or with “0” for retention. 

 l    The API now uses the correct XSD field length for Job Contract Number. 

 l API queries of general ledger accounts return the correct results for the account long name and account short 
name. 

 l    You can use the API to modify a vendor's PO/Contract Warning to any valid value. 

 l    The Heritage field in the U.S. schema has been updated to use Range20, which handles values 0 through 7. 
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Sage Construction Anywhere (SCA) 
Retirement

As of September 30, 2019, Sage retired Sage Construction Anywhere (SCA).    

Contact your Sage business partner to learn about alternative solutions.
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Summary of enhancements in earlier 
versions of Sage 100 Contractor (SQL)

Earlier versions of Sage 100 Contractor (SQL) provided a wide variety of new features, including many 
enhancements that our customers have requested.

The following table is a list of  the most significant features introduced in earlier versions, details of which you 
can read about in the Release Notes for the respective version. 

 
Enhancements by version

U.S. 
Only

Canada 
Only

 
API 

Version 22.4 enhancements 
(For details, see the v22.4 Release Notes)

Enhancements for 2020 1099 Reporting x   

Enhancements for 2020 ACA Reporting x   

Support for new T4 requirements related to COVID reporting  x  

Version 22.3 enhancements 
(For details, see the v22.3 Release Notes)

Reports on stored personal information    

Support for new W-4 forms x   

Support for Covid-19 related absences and wages    

Version 22.2 enhancements 
(For details, see the v22.2 Release Notes)

Integration with eTakeoff Dimension    

Refinements for 'Use Taxes' x   

Support for Equal Employment Opportunity Commission (EEOC) 
Reports

x   

Summary of enhancements by version
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Enhancements by version

U.S. 
Only

Canada 
Only

 
API 

Version 22.1 enhancements 
(For details, see the v22.1 Release Notes)

Command-level security for many options and Post commands    

Ability to save final reconciliations for later access    

Ability to transfer amounts between bank accounts    

Warning when posting an AP invoice with no subcontract    

Ability to view Sage messages in Sage 100 Contractor    

Job templates to use and reuse in takeoff    

Ability to report on use taxes x   

New payroll type for retiring allowances  x  

Several additional customer-requested enhancements    

Version 21.3 enhancements 
(For details, see the v21.3 Release Notes)

Some minor enhancements plus U.S. tax updates.    

Version 21.2 enhancements 
(For details, see the v21.2  Release Notes)

Ability to merge client records    

Ability to merge vendor records    

Ability to include a record's attachments when you email forms    

Ability to email statements to jobs and clients    

Ability to record external vendor payments    

Ability to specify a secondary backup location    

Ability to track vendor certificates by job    

More ways to list vendor invoices to pay    

Version 21.1 enhancements 
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Enhancements by version

U.S. 
Only

Canada 
Only

 
API 

(For details, see the v21.1  Release Notes)

Bank feeds    

Ability to email direct deposit stubs at a later date    

Enhanced cost type validation    

Enhanced Search (Find) in the 9-5 Jobs window    

Ability to move company to a new drive    

Ability to view an employee's pay raise history    

Ability to create timecards for individuals in Daily Payroll    

Ability to create payroll records for salaried employees    

Ability to restrict exclusive access for specific non-administrative 
users

   

Version 20.7 enhancements 
(For details, see the v20.7 Release Notes)

Ability to print a new 5-1-8-86  Vacation Hours Earned and Used 
Report

X   

Version 20.6 enhancements 
(For details, see the v20.6 Release Notes)

New Server Management Tools    

Ability to set records "Inactive"    

More efficient login    

Ability to replace Cost Codes, Vendors, Tasks, or Inventory Locations 
in a takeoff

   

New Combined Accounts Receivable and Service Receivables aging 
reports

   

Ability to print Accounts Receivable Aging Reports by Invoice Date    

Ability to print Accounts Payable Aging Reports by Invoice Date    
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Enhancements by version

U.S. 
Only

Canada 
Only

 
API 

Ability to print Service Invoice Aging Reports by Invoice Date    

New banking categories you can assign to bank-related journal 
transactions

   

Improved vacation tracking X   

Version 20.5 enhancements 
(For details, see the v20.5 Release Notes)

Ability to use new custom fields in most windows    

Ability to tag rows for followup in the 9‐5 Takeoffs grid    

Audit Information is available in Advanced Company Settings    

Numeric fields provide automatic calculation    

Easier access to user subfolders in workgroups    

Ability to correct the period of a posted payroll transaction    

Ability to skip automatic calculation during takeoff    

Ability to filter cost codes by Job and Phase in lookup windows    

Ability to filter unassigned work orders on the Dispatch Board    

A new option for saving and selecting company-specific custom 
reports and forms

   

Ability to use a new standard calendar to select dates    

Support for Microsoft SQL Server 2016 and Windows 2016 Server    

Ability to copy user process maps    

Ability to use high contrast display settings for Windows 10    

Ability to print a new Payroll Check Register 5‐1‐2‐31 by check date    

3‐7 Progress Billing and 12‐2 Inventory Allocation allow 5,000 rows    

Tax and Workers' Comp rates in 4‐4 and 4‐2 use 4 decimal places X   

Workers' Comp Reports 21, 86, and 96 show Overtime Hours X   
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Enhancements by version

U.S. 
Only

Canada 
Only

 
API 

Version 20.4 enhancements
(For details, see the v20.4 Release Notes)

Ability to copy external files to other users    

New option to approve the removal of employee records    

Version 20.3 enhancements
(For details, see the v20.3 Release Notes)

Ability to view change history in records    

New option for closing purchase orders automatically    

Support for Paya Exchange Desktop 2.0    

Support for customized tables and views    

Ability to use a new window to add client service locations quickly    

Effective rate shown for Sales Tax Districts (U.S. only) X   

API supports adding and removing attachments   X

API enforces locks   X

Schema change for Global Variables   X

Version 20.2 enhancements 
(For details, see the v20.2 Release Notes)

Simplified schedules lookup    

QueryJobCost (API Enhancement)   X

SetExclusive (API Enhancement)   X

Version 20.1 enhancements 
(For details, see the v20.1 Release Notes)

   

More versatile lookup windows    

Unique Payroll record numbers    
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Known issues and comments

The following sections describe known issues and problems in Sage 100 Contractor Version 23.1.

Compliance and Payroll Checks

Important! The sample check forms that come with Sage 100 Contractor may not be fully compliant with 
all federal, state, and local laws, and other requirements that can differ from one jurisdiction to another.  It 
is your responsibility to familiarize yourself with all applicable laws and requirements, and to modify 
check forms as needed to ensure compliance. For information about customizing check forms, see 13-5 
Form/Report Page Design in the Sage 100 Contractor help, or contact your Sage business partner for 
assistance.

Internet access required for Sage 100 Contractor
Sage 100 Contractor features, such as printing or efiling  tax forms, submitting enhancement requests, 
accessing Help, or downloading periodic product or tax updates all require Internet access. 

To take advantage of these features, ensure that any workstation or server that Sage 100 Contractor is 
installed on has access to the Internet. 

During installation of Sage 100 Contractor, the computer serving as the Sage license server must be able to 
connect to the Internet to obtain licenses. Once installation is complete, you can check out license uses for 
each computer where   Sage 100 Contractor is installed, then disconnect the Sage license server from the 
Internet. 

Configuring anti-virus software and third-party firewalls
During installation of the Sage 100 Contractor Hosting Framework, the Windows Firewall is configured 
automatically to enable the Sage 100 Contractor Hosting Framework to act as a TCP server. If you use some 
other firewall, you may need to manually adjust some settings in the firewall in order to ensure proper 
operation.

You can use the following procedure to configure the Windows Firewall manually to allow the Sage 100 
Contractor Hosting Framework to communicate with other computers. Use it as the basis for manually 
configuring other third-party firewall products.
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To configure the Windows Firewall:

 1. Click Start > All apps > Control Panel > System and Security.

 2. Open Windows Firewall, and then select Allow a program or feature through Windows Firewall.

 3. Select Sage 100 Contractor Hosting Framework on the list, if it is not selected.

Note: By default, the exception is set to allow access by any computer on the network. You can refine 
this setting by selecting the Change Scope button. Be aware that restricting the scope incorrectly can 
cause the computer to be unable to connect with some or all of the other machines on the network.

Files to exclude when manually configuring your firewall for Windows 8.1 Professional and Windows 
10 Professional 32-bit 

 l C:\ProgramData\Sage\Sage 100 Contractor SQL

 l C:\Program Files\Sage\Sage 100 Contractor SQL

 l C:\ProgramData\Aatrix Software 

 l C:\Program Files\Aatrix Software 

 l C:\%LocalAppData%\Sage\Sage 100 Contractor SQL

 l Network location of Sage 100 Contractor SQLdata. (If you install SQL Server Express using Database 
Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows 8.1 Professional and Windows 
10 Professional 64-bit

 l C:\ProgramData\Sage\Sage 100 Contractor SQL

 l C:\Program Files (x86)\Sage\Sage 100 Contractor SQL

 l C:\Program Files (x86)\Aatrix Software 

 l C:\ProgramData\Aatrix Software 

 l C:\%LocalAppData%\Sage\Sage 100 Contractor SQL

 l Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database 
Administration, this location is C:\Sage100Con\Company\.)

Software and hardware required to support Microsoft SQL 
Server
Version 23.1 requires an instance of Microsoft SQL Server. You can download and use Microsoft SQL Express 
at no charge, or you can use the full version of Microsoft SQL Server. You can even start using Microsoft SQL 
Express, and upgrade to the full version of Microsoft SQL Server later, if necessary.
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When you first open the new Database Administration tool, the program tries to configure an instance of 
Microsoft SQL Server with optimal settings for Sage 100 Contractor for you. If you do not already have an 
instance of Microsoft SQL Server, you can let the Database Administration tool download, install, and 
configure Microsoft SQL Express for you.

Refer to Knowledgebase article 111361 for detailed information about supported operating systems and 
software, and for minimum hardware requirements.

Installation of Microsoft SQL Server on a domain controller is 
not recommended
Microsoft recommends against installing SQL Server on a domain controller, and does not support SQL Server 
on a read-only domain controller should you encounter any problems with this configuration. 

Because you must install Database Administration on the same machine as SQL Server, you should not install 
Database Administration on a domain controller. To guard against inadvertent installation on a domain 
controller and the potential for irrecoverable data losses, you will receive a warning if you attempt to install 
Database Administration on a machine used as a domain controller .

For more information, see the Microsoft Knowledgebase article https://support.microsoft.com/en-
us/kb/2032911.

About .NET Framework

.NET 4.8 Framework is required

If Microsoft .NET 4.8 Framework is not already installed, it will be installed automatically when you install Sage 
100 Contractor. Installation of .NET 4.8 Framework alone may take up to 20 minutes per computer.

Make sure that both your client and server computers meet the minimum requirements for installing both Sage 
100 Contractor software and .NET 4.8 Framework. 

Note: If Sage 100 Contractor requires an installation of .NET 4.8 Framework, the Sage 100 Contractor 
installation process may continue automatically after the .NET Framework installation is completed. If 
you are prompted to restart your computer after the .NET Framework installation, you must do so to 
continue the Sage 100 Contractor installation. 

.NET 3.5 is also required

In some situations, you may need to turn on .NET 3.5 manually by selecting the .NET 3.5 check box in the 
Windows Features dialog box. For more information, see Knowledgebase article ID 68381, available at 
https://support.na.sage.com/selfservice/viewdocument.do?externalId=68381.
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Turning on Microsoft .NET 3.5

Microsoft .NET 3.5 must be available and enabled prior to installing Sage 100 Contractor. 

If you attempt to install Sage 100 Contractor  without .NET 3.5 installed, you receive the following message 
during the licensing install: 

“Sage.CRE.HostingFramework.Service v3.2 has stopped working.” 

When you click [OK], the installation continues, but the services have not been installed so Sage 100 
Contractor cannot open. The Sage.CRE.HostingFramework Service does not install unless .NET 3.5 is 
installed. If you receive the above message during installation, install .NET Framework 3.5., and then reinstall 
Sage 100 Contractor.

The following instructions are for Windows Server 2008 R2.

To verify that .NET 3.5 is installed:

 1. Click the Start button in the lower left corner of the display.

 2. Highlight Administrative Tools and select Server Manager.

 3. In the Server Manager interface, click Features to display all the installed Features in the right-hand 
pane.  Verify that .NET Framework 3.5.1 is listed.

To enable .NET 3.5:

 1. In the Server Manager interface, select Add Features to display a list of possible features.

 2. In the Select Features interface, expand .NET Framework 3.5.1 Features.

 3. Once you expand .NET Framework 3.5.1 Features, you will see two check boxes.  Check the box next to 
.NET Framework 3.5.1 and click Next.

 4. In the Confirm Installation Selections interface, review the selections and then click [Install].

 5. Allow the installation process to complete and then click [Close].

Note: Enabling .NET Framework 3.5.1 may require a reboot. 

About network configuration and TCP Remoting Channel
Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component, to enable 
communication among computers on a network. By default, Sage 100 Contractor uses the TCP starting port 
48760. Certain configurations can potentially disable the communication: 
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 l You must enable file sharing on your computers. To enable file sharing, follow the instructions in the 
Windows  Help.

 l TCP communication requires the selection of port numbers that are not in use by other processes on the 
local computer. 

 l Software firewalls running on the local computer can be configured to block processes from opening 
TCP ports, which will prevent communication through the TCP Remoting Channel. 

PCI DSS Compliance
PCI DSS stands for Payment Card Industry Data Security Standard. It was developed by the major credit card 
companies as a guideline to help organizations that process card payments to prevent credit card fraud, 
cracking, and other security weaknesses and threats. 

A company processing, storing, or transmitting payment card data must be PCI-compliant or risk losing its 
ability to process credit card payments and being audited and/or fined. (For more information about PCI 
standards, see https://www.pcisecuritystandards.org/.)

Sage 100 Contractor payment processing works exclusively with Paya to enable merchants to seamlessly 
process check and credit card transactions directly in Sage 100 Contractor. The payment processing program 
uses Paya Exchange, a secure payment-processing application, to connect to Paya and process check and 
credit card transactions.

Integrating your financial and operations system with Paya lets you process check and credit card transactions 
without storing your customers’ sensitive card information in your database. Paya Exchange transmits check 
and credit card details through a secure connection to Paya, where they are stored in a PCI-compliant vault, 
protecting your from exposure to non-compliance penalties and credit card fraud.

Caution! To avoid non-compliance with PCI standards, do not store credit card information in Sage 100 
Contractor. Such storage creates unnecessary risk for your business and your customers.

Tax Forms and eFiling by Aatrix configuration requirements
Tax Forms and eFiling by Aatrix requires an Internet connection for two reasons:

 l For updating forms and executable files.

 l For electronic filing (eFiling) of the forms.

If you experience an Internet connection problem, it may be due to problems communicating through an 
Internet firewall. Firewalls need to have access allowed through specific ports:

 l The Tax Forms and eFiling Updater uses standard SSL/HTTP port 80 to access the site 
http://updates.aatrix.com.

 l The eFiling component uses secure HTTPS on port 443 to access the site https://efile.aatrix.com.
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By allowing access to aatrix.com, you allow both updates and eFiling. Occasionally, restrictions are tighter and 
only allow access to these ports by specific programs. Tax Forms and eFiling uses the following programs to 
access the Internet.

For updating using http on port 80 to http://updates.aatrix.com:

 l aatrixforms.exe

 l updater.exe

 l updater2.exe

For eFiling using secure http on port 443 to https://efile.aatrix.com:

 l builder.exe

 l viewer.exe

Use Adobe Reader Version 8.1.3 or later for faxing
Customers have reported problems faxing from Sage 100 Contractor with versions of Adobe Reader earlier 
than 8.1.3. Adobe Reader Version 8.1.3 and later support faxing from Windows and from Sage 100 Contractor.

Important! To fax from Sage 100 Contractor, the Windows Fax Service component must be installed with 
your Windows operating system. For more information about installing the Windows Fax Service 
component, see the Sage 100 Contractor Help topic, “Installing the Windows Fax Service component.”

Configuring Windows Regional and Short Date Format

To specify regional formats for Windows:

 1. Click the [Start] button, point to Control Panel, then click Clock, Language, and Region .

 2. Click Region and Language.

 3. On the Formats tab, select the format for your country.

 4. Under Date and time formats, from the Short date format drop-down list, select  the format used for your 
country.

 5. Click [OK].

 6. Close the Clock, Language, and Region window.
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Windows "Sleep Mode" prevents computers from obtaining a 
license use
If the computer you are using as a license server goes into sleep mode, other computers on the network 
cannot obtain a license. 

To avoid this possibility, set Sleep Mode on your license server computer to Never.

To set the Sleep Mode to “Never”:

 1. In Windows 8.1 Professional, Windows 10, or Server 2012 Standard, click Start > All apps > Control Panel > 
System and Security > Power Options. 

In Windows 7, click Start > Control Panel > System and Security > Power Options

 2. Select Change when computer sleeps. 

 3. From the Put computer to sleep list, select Never. 

Sage licensing (Sage 100 Contractor Hosting Framework) 
cannot auto-start on Windows 8.1
The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers running 
the Windows 8.1 Professional or Windows 8.1 Enterprise operating systems. If the service stops, the program 
displays a message advising you to take further action to resolve this issue.
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